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* Objetivos da Aula

* Parte Tedrica
* Introdu¢ao aos modelos de equacgdes estruturais
* Parte Pratica

e Saber implementar os estudo dos pressupostos do modelo no SPSS
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MODELOS DE EQUACGES ESTRUTURAIS (Structural Equation Modelling):

extensao dos modelos GLM; técnica de modela¢ao generalizada,
para testar a validade de modelos tedricos.

Segue uma abordagem diferente:

Estatistica Classica: AMEE:
Teoria

Teoria) JE[o1S -

1. Podera este modelo explicar/gerar os dados

1. Qual 0 modelo que descreve os dados observados? Método Confirmatério
observados? Método Exploratério 2. A teoria é o “motor” do processo
g' zados f‘?m a dedug;éo g:le Teorias 3. Teorias diferentes podem ser testadas por
-NOVOS dados, hovas leorias formalizagéo e avaliacdo de modelos

distintos
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MODELOS DE EQUACOES ESTRUTURAIS

Vantagens face as abordagens classicas
1. Inclui no modelo variaveis latentes e manifestas (e o erro previsto)

2. Permite testar modelos complexos com varios tipo de varidvel e de relagdes (Permite testar ajustamento
global de modelos e significancia individual de parametros num enquadramento tedrico que engloba varios
tipos de modelos lineares)

3. Softwares intuitivos AMOS e SMART PLUS
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AS VARIAVEIS

 Variaveis manifestas ou variaveis observadas: Sao variaveis medidas, manipuladas ou observadas
diretamente.

 Varidveis latentes, fatores ou constructos: S3o variaveis nao diretamente observaveis ou
mensuraveis, sendo a sua existéncia indicada pela sua manifestacao em variaveis indicadoras ou
manifestas.

 Variaveis independentes ou exdgenas: as causas destas variaveis residem fora do modelo, i.e. nao
sao influenciadas por nenhuma outra variavel no modelo.

 Variaveis dependentes ou enddgenas: as causas da variacao destas variaveis residem no modelo,
i.e. a variacao destas variaveis é explicada por variaveis presentes no modelo
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AS COMPONENTES

e Modelo de Medida : define a forma como os constructos hipotéticos ou variaveis latentes sao
operacionalizados pelas variaveis observadas ou manifestas

« Modelo Estrutural : define as relacdes causais ou de associacao entre as variaveis latentes

Modelo de Medida: Modelo Estrutural:
vd.. y=An+te
V.i.: x=AE&+6

. Formalmente:
n=Bn+T§{+¢

assumindo que (pressupostos):
a. e e n) sdo independentes
b. d e £ sdo independentes
c. € e £ sdo independentes
d. ¢, € e d sdo mutuamente independentes

e. Os valores esperados dos erros € 0.
f. B,=0 (uma v.d. ndo é causa e efeito dela mesmo) e (I-B) € nao singular (i.e. tem inversa)
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AS COMPONENTES

* Modelo de Medida: define a forma como os constructos hipotéticos ou variaveis latentes sao
operacionalizados pelas variaveis observadas ou manifestas - . -

 Modelo Estrutural: define as relacdes causais ou de associacao entre as variaveis latentes

e @Graficamente:
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A ESTRATEGIA

Validagdo do
modelo Aceitacéo ou
Rejeigdo do
modelo
Estimacéao do
Modelo
j‘ Avaliagcdo da
qualidade do
Recolha de Q D Ajustamento
Dados Especificagdo e
identificagcdo do
O modelo

() Elaboragédo do a

modelo Tedrico

TEORIA
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1. DEFINIR O MODELO
TEORICO

* “Desenho” formal do modelo, que ilustra as
hipdteses sobre o modelo de medida e sobre
o modelo estrutural:

 Decidir:
1. Que variaveis manifestas operacionalizam
gue variaveis latentes; erros correlacionados?
2. Que relacdes causais entre v. latentes e/ou v.
manifestas devem ser incluidas / excluidas?
3. Que associacdes (nao-causais) devem ser
incluidas/omitidas do modelo?
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2. ESPECIFICACAO

 Uma das etapas mais complexas...
 Implica tomar decisoes e assumir

alguns pTESSUPOStOS Modelos reflectivos: Modelos formativos:
As v. latentes ‘reflectem-se’ nos itens; As ‘v. latentes’ sdo ‘formadas’ pelas manifestas;
. . o e As v. latentes manifestam-se através das v. Os itens podem estar ou ndo correlacionados,
* Em prlme"o Iugar temos de deflnlr manifestas positivamente ou negativamente
que tipo de modelo de medida: Os itens devem estar correlacionados positivamente
L L E ~
Modelo reflectivo ou formativo? L ® : Portugugs
Febre
. Matematica
Aptidao
Dores Musculares @ Acesso
Universidade Biclogia
Dores Garganta @ g
Nariz congestionado Psicologia
Cansaco 4—@ (Esta Aptidao de Acesso Univ. ndo e
verdadeiramente latente, ja que € uma combinagao
(estimaveis pelos modelos de Eq. Estruturais) de v. manifestas (média ponderada). Nao é
estimavel com AEE, mas sim com PLS)
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2. ESPECIFICACAO

Uma das etapas mais complexas...
Implica tomar decisdoes e assumir
alguns pressupostos

Depois identificar as ligacoes, erros e
possiveis associacoes com base nas
decisdes (os softwares ajudam nesta
definicdo de parametros)

Algumas ‘regras’ de especificagao:

ANALISE DE DADOS EM GRH

Modelo de Medida (AFC)
1.

Factores comuns latentes (£) causam as v.
manifestas (z,,....2,). O comportamento
das v. manifestas resulta da manifestacéao
dos factores latentes;

A variancia das v. manifestas (e.g. erros
de medida) que n&o é explicada pelos
factores comuns latentes é explicado por
factores especificos latentes (g,,...,¢,);

Os erros de medida s&o geralmente
independentes (mas podem estar
correlacionados indicando uma fonte de
variagdo comum dos itens n&o explicada
pelos factores comuns presentes no
modelo).

Modelo Estrutural (RL)

1. Asrelagdes s&o ‘desenhadas’ de causa-
para-efeito

2. A variancia da v. exogenasnao explicada
pela combinacgdo das v. endégenas &
explicada por ‘erros’ (Disturbances ou
Perturbagdes)

Conhecimento
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ESTIMACAO

Contrariamente ao paradigma
classico, nesta abordagem
modelamos as matrizes de variancias-
covariancias (ou de correlagoes) das
variaveis manifestas (nao os dados
individuais!)

O objectivo da AEE é entao encontrar
um vector de estimativas dos
parametros do modelo (g) que
reproduza o melhor possivel a matriz S

das v. manifestas na populacao

Os softwares de AEE utilizam um
algoritmo iterativo que minimiza uma
funcao da diferenc¢a

Métodos de ajustamento mais usados:

* Maxima verosimilhanga (ML)

*  Minimos quadrados ndo-ponderados (ULS)

* Minimos quadrados generalizados (GLS)

*  Minimos quadrados ponderados generalizados (WLS)
 Minimos Quadrados Parciais (PLS)

|

Smartr®

4'll

:
6
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3. AVALIACAO DA
QUALIDADE

(1) Teste do Qui-quadrado
(2) indices de qualidade de ajustamento

(3) Analise de residuos, estimativa de
parametros e fiabilidade individual de Estatistica Cléssica: AMEE:
indicadores

Teoria

ey Dados -

e

1. Podera este modelo explicar/gerar os dados
observados? Método Confirmatdrio

2. A teoria é o “motor” do processo

3. Teorias diferentes podem ser testadas por
formalizagéo e avaliacdo de modelos
distintos

1. Qual 0 modelo que descreve os dados
observados? Método Exploratério

2. Dados levam a deducéo de Teorias

3. Novos dados, novas teorias



& Management

Uriversidade de Lisboa

3. AVALIACAO DA
QUALIDADE

(1) Teste do Qui-quadrado

Hipotese nula: a matriz de covariancia
populacional é igual a matriz de
covariancia estimada pelo modelo

Queremos aceitar a hipotese nula, neste
caso

NN ANALISE DE DADOS EM GRH

Devemos reportar mas nao é bom indicador :

Muito sensivel a dimensao da amostra
(amostras pequenas: raramente rejeita HO,
Amostras grandes: Rejeita quase sempre HO)
Muito sensivel a violacao da normalidade
multivariada (com risco de rejeicdao de bons
modelos e aceitacdo de modelos maus!)

14
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3. AVALIACAO DA
QUALIDADE

(2) indices de qualidade de ajustamento

Avaliam a distancia relativa entre a matriz
dos dados e a matriz da populacao.

v

Existem centenas!
Tipos de indicadores

NN ANALISE DE DADOS EM GRH

Indices Absolutos: Avaliam a qualidade do modelo
per se, sem comparagcao com outros modelos: RMR,
GFI

Indices Relativos: Avaliam a qualidade do modelo
sob teste relativamente ao modelo com pior
ajustamento (mod independéncia) ou melhor
possivel (mod saturado): NFI, CFI C

Indices de Parciménia: indices relativos que
incluem uma penalizacao devida a complexidade do
modelo: AGFI, PGFI, PCFI

Indices baseados na teoria da informac3o:
Apropriados para comparar varios modelos
alternativos que ajustem aos dados (AIC, BIC, ECVI)
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3. AVALIACAO DA
QUALIDADE (2)

(2) indices de qualidade de ajustamento

Avaliam a distancia relativa entre a matriz
dos dados e a matriz da populacao.

Indices recomendados de acordo com
Maroco, 2013

NN ANALISE DE DADOS EM GRH

Estatistica Valores de Referéncia

(Macro do AMOS: \cmin; \p)

X2 e p-value (H,: O Ajustamento é perfeito)

Quanto menor melhor
p>0.05

X2/df (Macro do AMOS: \cmindf)

< § — ajustamento sofrivel
< 2 - ajustamento aceitavel
~ 1 — ajustamento bom

CFl  (Macro do AMOS: \cfi)
GFl (Macro do AMOS: \gfi)

<0.8 — ajustamento mau
[0.8;0.9[ - ajustamento sofrivel
= 0.9 — ajustamento muito bom

PGFI (Macro do AMOS: \pcfi)
PCFI (Macro do AMOS: \gfi)

< 0.6 — Ajustamento mau
[06; 0.8[ - Ajustamento bom
>0.8 — Ajustamento muito bom

RMSEA (com I.C. 90%)

e

p-value (H,: rmsea<0.05)

(Macro do AMOS: \rmsea; \pclose)

> 0.10 - Inaceitavel

10.05;0.10] - ajustamento sofrivel
=0.05 - ajustamento bom

p-value 20.05 (=0.5 segundo Joreskog)

AIC (Macro do AMOS: \aic)
ECVI (Macro do AMOS: \ecvi)

S0 para comparar modelos
Quanto menor, melhor...

16
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3. AVALIACAO DA
QUALIDADE (3)

(2) ) Andlise de residuos, estimativa de
parametros e fiabilidade individual de
indicadores

Ou seja: O modelo pode ter um bom
ajustamento global, mas ainda assim
apresentar um mau ajustamento local.
Para fazer o diagndstico de possiveis
problemas locais:

NN ANALISE DE DADOS EM GRH

A. Avaliar os residuos estandardizados (problemas:

B.

residuos > 2, outliers)

Avaliar os erros-padrao assimptoticos dos
parametros do modelo e sua significancia
(problemas: erros-padrao superiores (2x) a
estimativa do parametro; parametros nao
significativos )

Fiabilidade individual dos indicadores/manifestas
(problemas: Valores de R? <,025)

17
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3. AVALIACAO DA
QUALIDADE (4)

(2) E se a qualidade nao for boa??

E pratica corrente, modificar o modelo
eliminando vias nao significativas,
libertando parametros

anteriormente fixos, fixando parametros
anteriormente livres, correlacionar erros,

Os softwares também d3ao outras pistas:
Indices de modificagao!

ANALISE DE DADOS EM GRH

Validag&o do
modelo
()
Estimag&o do ./
Modelo C S
N
4 Avaliagdo dg
qualidade do
Recolha de Ajustamentq
Dados Especificacao e
identificagcao do
Q modelo

() Elaboracéo q
modelo Tedrid

Qo O

t

|

©
TEORIA

Maroco recomenda apenas alterar
o modelo se houver fundamentos

tedricos para+ Ml >11

Aceitagédo ou
Rejeicdo do
. modelo

*A atualizacdo do modelos deve
ser feita sequencialmente,

comecando por libertar o
parametro com maior Ml

18
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3. AVALIACAO DA
QUALIDADE (4)

(2) E se a qualidade nao for boa??

E pratica corrente, modificar o modelo
eliminando vias nao significativas,
libertando parametros

anteriormente fixos, fixando parametros
anteriormente livres, correlacionar erros,

Os softwares também dao outras pistas:
Indices de modificagao!

NN ANALISE DE DADOS EM GRH

Maroco recomenda apenas alterar o modelo se houver
fundamentos tedricos para o fazer e/ou de Ml > 11

A atualizacdao do modelos deve ser feita sequencialmente,
comecando por libertar o parametro com maior Ml até chegar
ao parametro de menor M.

19
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5. VALIDACAO

Pressupostos

1. Normalidade multivariada

2. Linearidade: aplicado a matriz de
correlacOes (entre manifestas)

3. Covariancias amostrais nao-nulas
4. Multiplos indicadores para cada latente
5. Auséncia de Multicolinearidade
6. Amostras de “grande” dimensao
7. Modelos sobre-identificados

8. Medida “forte”

9. Sem outliers

NN ANALISE DE DADOS EM GRH

Pode ser avaliada com:

1. Assimetria (skewness - "sk") e Curtose (kurtosis -
"ku") | Kline (1998): Valores de |Sk| <3 |[Ku| <8

2. Graficos de dispersao

3. Matriz de correlagdes (p<0,05)

4. Mltiplos indicadores | Modelo

5. Auséncia de Multicolinearidade | VIF

6. N>200 — 400 ; 15 sujeitos por variavel manifesta; 5
sujeitos por parametro a estimar

7. Medidas de ajustamento local

8. Escala (ordinal) deve ter pelo menos 5 pontos

9. AMOS testa a distancia de Mahnalobis *convém que p1

seja pequeno (0.05-0.10), e p2 seja grande (>0.05-0.10), caso contrario a observagdo

deve ser um outlier multivariad 20
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4. REPORTE

Recomendacoes:

* Reporte baseado nas estimativas
estandardizadas

* Incluiinformacao sobre a variancia
explicada pelo modelo de medida (em
geral e para cada item);

* Incluiinformacao sobre a variancia
explicada pelo modelo estrutural (em geral
e para cada VD);

* Inclui representacao visual do modelo

21
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Anadlise Estatistica

O modelo de moderagdo do Conhecimento prévio a matematica sobre a Motivacdo matematica e a influéncia
destas variaveis na performance a matematica foi avaliado por intermédio de um modelo de equacgdes estruturais
com efeito de moderacdo. O factor latente de moderacdo foi definido pelo produto, em pares, dos itens reflexos
dos factores ‘Conhecimento Prévio’ e ‘Motivacdo Matematica’. O ajustamento do modelo de moderacéo fo1
efectuado em duas etapas: a primeira de validagdo do modelo de medida, e a 2* de ajustamento do modelo de
moderac¢ido. O ajustamento do modelo foi feito por recurso ao software AMOS (v. 17, SPSS Inc, Chicago, IL). Na
avaliacdo da qualidade do ajustamento utilizaram-se os indices CFI, GFI e PCFI, PGFI tendo-se considerado que
estes indicavam um bom ajustamento para valores superiores a (0.9 e 0.6, respectivamente. Utilizou-se também o
RMSEA com 1.C. a 90% e a probabilidade do rmsea<0.05. Considerou-se que um I.C. para o RMSEA a 90% com
limite superior inferior a 0.10 ¢ indicador de um ajustamento razoavel, e que o ajustamento ¢ muito bom quando
o limite superior do I.C. ¢ inferior a 0.05 (Maroco, 2008). A significancia do efeito de moderacdo foi avaliada
com um teste a significancia do coeficiente de trajectoria associada ao efeito de moderagao.

Resultados

A figura 1 ilustra as estimativas dos parametros quer do modelo de medida (pesos factoriais) quer do modelo
estrutural de moderagdo. Observou-se um efeito de moderagao do Conhecimento prévio sobre a Motivagdo
matematica na performance a matematica (3py; cppang=0-220; p<0.001). Sendo o efeito de moderagdo positivo
podemos afirmar que quanto maior for o conhecimento prévio maior sera o efeito da motivagdo matematica sobre
a performance a matematica. Observaram-se ainda efeitos directos do Conhecimento (Bpy -=0.429; p<0.001) ¢
Motivacao (Bpy y=0-409; p<0.001) estatisticamente significativos.

©Maroco

22
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Conh.Mat.

Previo
pm3 8 83
mm1 g m1 .81‘_@
m2 4—@
mm3 m3  (e—612
81

P99 90

Figura 1. Modelo de moderagido do conhecimento prévio sobre a motivagdo Matematica na performance a Matematica
(X?/df= 1.8;CFI = 0.991,GFI =0.973 ; PCFI =0.721 ;PGFI =0.599 ¢ RMSEA=0.04; p=0.891; I.C. 90% ]0.026; 0.053[ )

23
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©Maroco

Objectivo:

Gerar um modelo com variaveis manifestas e latentes com o
programa AMOS

Segundo Warren, White & Fuller, (1974) a performance de um conjunto de administradores
de uma cooperativa agricola € fungao de um conjunto de variaveis latentes que incluem o
Conhecimento técnico, o Valor e a Satisfacao dos gestores. Cada uma destas variaveis foi
avaliada com um teste constituido por duas metades equivalentes. O modelo GEE
proposto € ilustrado na figura seguinte:

G)—1 G

b2 02

Conhecimento

o- Vi
Valor

Ajuste o sub-modelo de medida, e o modelo geral. Avalie a qualidade do ajustamento em
cada uma das etapas.

24




1. Desenhar o modelo

Organizacgao:

Menu de Comandos [

Botdes de Desenho e

Especificagdo de
Comandos

Area de
Mensagens de
Analise

¢t Unnamed project : Group number 1 : Input -

P=1lc

Eile Edit Yjew Diagram Analyze Tools Plugins Help

L af =
{0 )

= % Gioup number 1
i B E_

||||| |”|| ||||| Default model

?q Unstandardized esimates
Standardized asimates
o

Botdo | Fungao Funcéo
[ |Desenhar variavel manifesta Visualizar variaveis na base de dados
| |Desenhar variavel latente Visualizar varidveis no modelo
:&z Desenhar modelo de medida Se[gc;io do ficheiro de dados e grupos para
- - - analise multi-grupos
_4'.= Desenhar trajectdria causal (Causa para efeito) Especificagdo das propriedades da analise
++ |Desenhar relago correlacional (método de estimacéo; outputs, ...) i
— — Calcular estimativas dos pardmetros e medidas
& Adicionar ‘erros’ as variaveis de ajustamento do modelo
dm| | Seleccionar um objecto Visualizar o Output com resultados da analise
@] Seleccionar todos os objectos Modo de ‘Desenho’ do modelo
™ | De-seleccionar todos os objectos
; ; Modo de ‘Visualizagdo' das estimativas dos
Capiar objecto cd
—& P J Parédmetros e estatisticas de ajustamento
- Mover objecto — -
X A bect Estimagao Bayesiana
= pagar objecto 52 |Andlise Multi-grupos
i |Especificar propriedades dos objectos - 3

Pesquisa de Especificaco (Specification search)

Estimar o
modelo

©Maroco
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1. Desenhar o modelo

©Maroco
O~
Q)
» Seleccione a ferramenta de desenho do modelo de medida OI*D - O
. ) ' » Proceda de forma semelhante O~ _
(O cursor, na area de desenho, passara de (3 para ¥ ) para os restantes factores: o N[O
» Clique, com o botdo esquerdo na area de desenho, ¥ ' o 50
e arraste o cursor para desenhar um circulo com as [ o~
dimensdes apropriadas; -
. prop ’ - » Desenhe as trajectorias causais entre os
» Clique duas vezes com o bot&do esquerdo para O
s . . factores usando a ferramenta O
adicionar 2 itens e respectivos erros N ato
Nota: A ferramenta do modelo de medida, identifica por ' ' ~ O‘{",‘f“}_ ~ X,
: L o | » Desenhe as Correlagdes entre os factores usando O — O
defeito uma trajectoria da v. latente para o 1° item e as O
. . a ferramenta «» i G P
trajectdrias dos erros para os itens, com o valor 1. Estes O™
valores podem ser alterados posteriormente
» Rode os itens para o lado esquerdo usando o botdo O~ Nota: No AMOS texF, as correlag:r.:es entre factores O
) latentes sdo assumidas por defeito, mas no AMOS c J \ T .t
, w O "‘D\' - " D‘ C
O__D/ graphics, WYSIWG e portanto estas tém de ser ] (_Q—'— i_/\Dﬂ
desenhadasl!... o _ Jjé
7 1 D‘_» —



2. ldentificar variaveis

» Abrir o ficheiro de dados

2. Lap Zndt ¥ | It 5 (an hndt % 1
g’g& mod1 : Group number 1: Input
of2.% File Edit View Diagram Analyze Tools Plugins Help
T e Y
o 5
Group number 1
- i} =
Mie] = &
TLRURG
9™ X
-0
# C E
=0
lot ¢ Defautt modsl
R (=l =
s Data Files
i |
Group Name | File |‘u’an’able | ‘u’aluel N
Group number 1 BDAMOS_waren .csv 58/98
q
File Name I forking File | Help
View Data | ariable | £ alue
!
g oK | Cancel
[T Allow non-numeric data [ Assign cases to groups

» Clique com o botao direito do rato em cada um dos
circulos (v. latentes) e seleccione a opgéo ‘Object Properties’

, W OtPopater. | W0
8:%{.- Oraw ath 5
4+ Draw Covanance F6
\ K Frase DELETE
Z Duplicate
i35 Move Parameter
it  Shape of Opject
M, Touch Up CTRL+H
= Toggle Observed/Unobserved
(3 Rotate
3% Reflegt

» Digite “Conhecimento” na caixa ‘Variable name’:

foYe)

¢ Object Properties

R

Text | Parameters | Colors | Fomat | Visbity |

Font size

Font style

Ca—

Vanable name

[Regur  ~]

I Conhecmento

Variable label

e cligue no botZo & para fechar o menu.
» Proceda de igual modo para as restantes

v. latentes

» Clique no botdo = para listar as variaveis presentes na base de dados

©Maroc

» Clique em cada variavel e, sem largar o botdo esquerdo do rato, arraste-as até ao item
correspondente:

» Adicione o erro (Disturbance) da v.lantente ‘Performance’ (d1). Clique na ferramenta

e clique em cima do ‘circulo’ da ‘Performance’:




3. Identificar variaveis

» Adicione os erros manualmente, ou recorra ao menu ‘Plugins » Name unobserved variables':

Draw Covanances
Growth Curve Model

Name Parameters

Name Unobserved Vaniables

Resize Observed Variables

©Maroco

» Finalmente, recorra as ferramentas de retoque para melhorar o aspecto grafico do modelo.

Devera obter algo do tipo:

28



4. Estimar o modelo
©Maroco

» Clique no botao e especifique o método de andlise e as opgdes de output, clicando nas » Clique, finalmente, no botéo para ajustar o modelo
patilhas ‘Estimation’ e ‘Output’ (as outras sao irrelevantes na maioria das aplicacdes de AMEE)

y e —— 2~ | B pwe— ) Nesta fase, e se ainda ndo o fez anteriormente, o AMOS pedir-lhe-a para gravar o seu modelo
Extmaton | Numercal | Bos | Output | Boctsirep | Permdatiors | Rancom #] Thle | Esimation | Numercal | Bos O | Boksirep | Femuabions | Random #| Toe | grafico, dando um nome ao ficheiro do tipo *.amw:
I T ] s s =3~
S ¥ Minimization history ¥ Indirect. direct & fotal efiects O F « soes s 2005 s cames - [ |[Sear 2

R I P— Rl it ot
.  Maximumlikelhood intercepts | ¥ Smndardized estimates ¥ Factor score weights o g e Dok ol Towe. Sae

" Generslized leastsquares 8 ExSWheaton amw

e ¥ Squared multiple conelations I Covariznces of sstmates e
£ Unweighted least squares B o
" Scale-free least squares s b2 Conelaions.of sofmerca : :.:::::::::';::::u&.mw
l_ Chicarract 1 Aj?tqlmulMtl(ohUmvamdn.-nw
" Asympioacally distribubion-free I™ Implied moments F Criticol ratios for differences ] Regressio Linear Multipls.amw
8 Regreszio Linear Mutipl Multivarisds ..
- it o e daiae (| T Al implied moments W Tests for normality and culliers. t il RO . 2
Fertre " o <+ Digite aqui 0 nome do ficheiro
I™ Residual moments I™ Observed information matrix vt Ui e —
= Fi u i
I Fit the saturated and independence models I ey [E rereemem
1 Fit the saturated model caly ¥ Modification indices 1 i‘l'nl:.rcsshldbrmﬂ&aﬁon

!  Fit neither model !
i i
— ) == )
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5. Analisar o output

Para visualizar o ficheiro de output completo (Wheaton.AmosOutput)

» Clique no botéo E& ou no menu ‘View » Text Output’ (F10), para abrir o visualizador de

outputs (AMOS output)

N° de casas decimais dos
valores no output

Arvore de Navegagao
do Output

Clicar no sinal [+] para
expandir a arvore de
navegacdo e visualizar
o oufput na janela de
output

colunas

Espacamento entre

£8t Ames Output

v

b &S0

m B[z -7 -0

(FEOEmE : @

Whesion_final amw
- Anaiyms Summany
Hotes for Group
o Viasable Summany

Analysis Summary
Date and Time

Date: donngo, 12 de Outubro de 2008
Time: 11:05:02

Title

Wheaton_final: domingo, 12 de Outubro de 2008 1105

-

Aread
Outpu

e.g. Coeficientes de trajectdria e pesos factoriais (Regression weights):

Estimativas do coeficiente
I"I Estimativas dos SE da estimativas

Trajectérias )—\

i

12 Amos Output ! M
Ré&EWE & -7\-0 -[FOEE 20| —
Wheaton_final.amw - -
& Analysis Summary Regression Weights: (Group number 1 - Default m¢del)
Notes for Group J
s Sy Estmate SE. CR P Label
'arameter summary
& Notes for Modal 3 Performance <--- Valor 231 100 2300 .021 par 5
& Estmates Performance <--- Conhecimento 494 177 2786 005 par 6
& Scalars SR
Performance <--- Satisfagdo 077 .061 1259 208 par 9
Standardized Regressi Cc2 <--- Conhecimento 1.000
Covariances C1 <--- Conhecimento 1463 344 4252 *** oparl
Corelations: V2 <= Valor 1.000
Vanances:
Sauared Mukiple Comel \%1 <--- Valor 1311 318 4128 *** opar 2
& Matnces ~| S2 <--- Satisfagdo 1.000
%l 4 | P S1 <--- Satisfagio 1263 699 1806 .071 par3
P1 <--- Performance 1.000
P2 <--- Performance 867 116 7450 *** par 4

©Maroco

C.R. Critical Ratios
Z=Est/SE ~N(0,1)

P-value associado a
Z=Est/SE ~N(0.1)
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5. Analisar os outputs

Os resultados da andlise podem visualizar-se rapidamente na area de desenho, ou
extensivamente no ficheiro de output.

Standardized estimales

Correlagéo entre factores
Conhecimento e Satisfacdo
(Rf‘rum_‘:ulf:”'UG)

Estatistica do y* e respectivo p-value

Coeficiente de trajectoria do
factor Conhecimento para factor
Performance (3p-=0.52)

Proporgéo da varidncia do

item P1 explicada pelo factor

Performance (R?p, p,,~=0.73)
73

eqplo de Performance(Warren et al. 1974)
X2(14)=10.335; p=737

()
(2)
Peso factorial do factor

Performance no item P2
(Vp2per=0-82)

©Maroco

Para visualizar o ficheiro de output completo (Wheaton.AmosQOutput)

» Clique no botédo E& ou no menu ‘View » Text Qutput’' (F10), para abrir o visualizador de
outputs (AMOS output)

N° de casas decimais dosh /ﬁ‘ Espagcamento entre

valores no output colunas

£1¢ Ames Output v ]

REWE o e -7 -0 [FOEE : @

Wihaaton_final amw natvas &
Arvore de Navegacgao et ) '

do Output || | P

- Nobea for Model Date: domsingo, 12 de Ounibeo de 2008

i Time: 11:05:02 . Area de
Clicar no sinal [+] para [Py Output

exPand" ra é”’fore Eje T x:;'.. Time Wheaton_final: domingo, 12 de Cutubro de 2008 1105
navegacdo e visualizar
o output na janela de
output
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5. Analisar os outputs
©Maroco

e.g. Coeficientes de trajectoria e pesos factoriais (Regression weights): e.g. Indices da qualidade do ajustamento (Model Fit):
Trajectérias Estimativas do coeficiente 181 Amos Outpat B
ﬂ Estimativas dos SE da estimativas Y “:n U@ neads -7 -0 [[FOWE 0
o “ | Model Fit Summary 3
s Amoe Ot \ [ ] SIS -k Crica e o e
RSLE ® ma -7\ -0 ([FOEE Q| | Z=FEst/SE . Py e
Wheston_final amw 7 et 'J Model NPAR CMIN DF P CMINDF |
& mﬂs:::y Regression Weights: (Group number 1 - M-h-}u; ! j { 7~ Ry - | ;.—“? - Dﬁin:d:dd ;25 10 3(3)3 l; 737 738 ] gmé - :
# Vanable Summary Estmate SE. CR P Label Z=E8t/SE Independence model 8 243768 28 000 8706 Hée 1wt Fwe  Qovore 2
Paramater summary Cortorts | e | Gowen | |
& Notes for Mods! Performance <--- Valor 231 100 2300 021 par5 VRGP o o=
& Estimates Performance <--- Conhecimento 494 177 2786 005 par 6 Groug rusber | Model RMR  GFl AGFl PGFI 6 @ Wi n 78 @
B Wi Perf e <--- Satisfagdo 077 061 1259 208 par 9 Defack model 003 2 035 3% ot 'Mu(mm&ﬂnm;mﬂm
Fecmeson WS c2 . Cotherimarts 1.000 DetnA mode Saturated model 000 1 5 :D-n-v-»bu Bk AN Ve OV e oy
3 - GFl value = () Acsendices. 2
c1 <--- Conhecimento 1463 344 4252 *** 1 Independencemodeh | ‘A0 __ 31 oo A Moo cr=1-L
: ; ) ; par_ | GEI = 975 for the Default medsl model e ] v
f; Cousiations; V2 <--- Valor 1.000 Baseline Comparisons ' 2 (0 v Mo '
- Vanances: . whete. 7 i the minimum valus of the discrepancy function defined in Appendic
Ssared Muliple Cord Vi <= Valor 1311 318 4128 *** par 2 + @ D movnm v : y
NFI RFl IF1 T + @ Meanses based o Sand 15 0btaNed by evakuitng F with <(g) _ o, 7~ 1 2...G An
il R e I A 0 -0
il S | |52 <--- Safisfacio 1.000 Mol Detal thol e tho2 O % @ Compamoraimat mm:m-umhwwmmm)n ol
e s1 < Satisfagdo 1263 699 1806 071 par3 Defaut model 958 915 (1016 1034 1000 8 @ remeviaun | | Appnth o et o 341 _ g For e papom f compirg 7|
P1 <--- Performance 1.000 s""’""‘:o“ lg - 'g i 'x §Eﬁ the case o masemum Wakhood etmatn, f{E18); (51| i sssenten
P2 <--- Performance 867 116 7450 *** par 4 Jndependeece o< = : : e L bkt
- . ; (£9; 8'%)=§ ol (s - 52|’
- E possivel clicar Frome i A )= e )
em todos 0s w‘msm‘ with g8t \*t‘(f‘“),mcim 15 the masmum Ikeshood estimate
elemento do output e
a o OR i lass than or equal to 1. A value of 1 indicates a perfect fit.
e chamar o help — v Use the \gh taxt macrg to display G on & path diagram. o
do AMOS — —
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